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Fortifying your PC against malware

M
ilt Broedel teaches the computer
class just two doors down the hall
from Bob Schaffer’s ESOL class at

the Utica Access Site of the Madison-Oneida
BOCES. Milt is thoroughly schooled in
computer know-how and is a skilled and
organized presenter. This will be his second
visit to the MVPCUG. 

On Tuesday, May 2, at 6pm in the Whitesboro High

School cafeteria, Milt will provide the valuable service of

preparing us for the war against malware, which includes:

* Adware * Spyware

    * Spam * Viruses

    * Trojan Horses * Worms 

* Phishing Schemes * Identity theft

* Hackers, Crackers

     Then he’ll present various methodologies to protect

against these threats, which include:

* Anti-Virus Programs           

* Anti-Spyware Programs

    * Firewalls

* Spam Blockers

    * Password Protection

    * W ireless Encryption

    * Basic Security Measures �

COMING ATTRACTIONS

June — The Whittles

Picks for the Digital Home: 

Quality Technologies 

Sept. — Guru Nite

Our Annual Q&A Fest

Oct. — Al Fasoldt

The Man Who Tells It 

Like It Is!

Dec. — Lisa Britt

Do You Know Who Is

Watching You?

 On our website 

— Links of Interest —

Go to: 

mvpcug.com/index1.htm

   * www.adaware.com

   * http://tinyurl.com/pf7dw

   * http://tinyurl.com/zgeok

 Click on the links to find out  

more about these subjects.

Milt Broedel

http://www.adaware.com
http://tinyurl.com/pf7dw
http://tinyurl.com/zgeok


Stay connected . . . to the MVPCUG
Mohawk Valley PC User Group, Inc.
$25 for initial sign-up  - $20 for renewal

  Name___________________________________________________
  Address_________________________________________________
  City__________________________________________________NY
  Zip___________________Phone_____________________________
  E-mail___________________________________________________

Please mail this application with a check payable to MVPCUG to
M V P C U G
PO Box 586

Marcy NY 13403-0586
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The MVPCUG EXPLORER is published monthly from September

through June by the Mohawk Valley Personal Computer User Group,

Inc.(MVPCUG), PO Box 586, Marcy NY 13403-0586.

Opinions expressed herein are the writers and are not reflective of

the MVPCUG, nor are they considered substantiated by inclusion in

this newsletter. All articles are copyrighted by their respective authors

but may be reprinted by other User Groups provided credit is given to

the author and this publication.

The. MVPCUG was founded in 1981 by individuals interested in

IBM compatible computers. This non-profit organization consists of

volunteers whose expertise range from novice to professional.

Regular meetings are held on the first Tuesday of the month at

6pm, usually at the Whitesboro High School, Route 291, Marcy NY.

A typical agenda consists of discussion of business affairs and a

demonstration of computer related products.  Meetings are open to the

public.

Initial membership fee for an individual is $25. Annual renewal
dues are $20.
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Editorial notes . . .

Kim Komando’s columns

on page 5 were written

before Microsoft announced

the delay of Vista’s release

until 2007.

The information she relates in the columns

still hold true, although you will have to wait a

while longer to purchase a new computer that

will come with Vista installed. Pay heed to the

requirements necessary for Vista if you are

thinking of purchasing a new computer prior to

the release of the new operating system and

be prepared to do a complete install rather

than an upgrade when Vista finally is released.

Meeting Agenda

5:30 . . . . . . . . . . . . . . Meet and Greet
6:00 . . . . . . . . . . . . Business Meeting
6:30 . . . . . . . . . . . . . . Program, Part 1
7:00 . . . . . . . . . . . . . . . . . . . . . . Break
7:15 . . . . . . . . . . . . . . Program, Part 2
8:15 . . . . . . . . . . . Drawing for Prizes
8:30 . . . . . . . . . . . . . . . . Adjournment
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The MVPCUG general meeting was held at the Whitesboro
HS cafeteria. President Jerry Finkelstein called the meeting to
order at 5:59 PM. There were 39  persons in attendance.

BUSINESS MEETING

Treasurer Bill Gorrell reported that income was
$225.80, expenses were $109.95, and there is a
balance of $3921.36 as of March 31, 2006.

Jerry then announced that club members should
look at the links provided by Lisa Britt in the on-line
version of the newsletter. Jerry noted that many
magazines offered web versions and that these
versions frequently offered direct links to web sites
which provided additional information on the topic.

Jerry then announced that the board of directors 
planned to sell surplus club equipment no longer in use
before the summer break. A list of the equipment
items to be sold will be placed on the web site. As an
aside, Jerry also reminded the group that club
members were free to bring computer items for sale to
all club meetings.

The April Q & A SIG will be held on Thursday,
April 6  at St. John’s Church in Whitesboro. Any andth

all topics are allowed. If members do not participate
by attending SIGs, the SIGs will be discontinued.

A question was raised about when the club could
conduct 50-50 drawings. Bill Gorrell indicated that
although the state had cashed our check for the
change in incorporation, we have not received
approval for the change. Until approval arrives, we
will be unable to conduct 50-50 drawings.

Helen Russell asked how to remove a center line
from a WordPerfect document. Donna Gorrell
answered the question.

PROGRAM

At 6:15 PM, Jerry introduced the speaker for the
evening, Linda Oltz. Linda’s presentation focused on
how to better use Microsoft Word. The first half of
her presentation dealt with the creation of macros. 
Macros are short bits of computer code that create
shortcuts that automate repetitive tasks. Linda
indicated that macros can be used in all types of
documents including spreadsheets, word processing,

desktop publishing and presentation software
(Powerpoint).

The second part of Linda’s presentation focused
on techniques related to newsletters. This included a
number of helpful tricks for those who wish to create
professional-look newsletters.

This part of the program was marred by the noise
coming from the adjacent lobby as another group held
a coffee break in that area. The noise made it difficult
for many to hear much of Linda’s presentation. To
help members retain information, Linda distributed
handouts with all the software commands she
discussed. The program concluded at 8:20 PM.

DOOR PRIZES

[furnished with club funds]

56K modem . . . . . . . . . . . . . . . . . . . . . Louis Barile
Photo paper . . . . . . . . . . . . . . . . . . . Bob Humphrey
15 CDRs . . . . . . . . . . . . . . . . . . . . . . Helen Russell
10 DVD+R . . . . . . . . . . . . . . . . . . . . . Joe Madeira

[donated by Que/Sam’s Pub Co]

Guide to Word 2003 . . . . . . . . Neville Hendrickson

[donated by Rod St. Clair]

McAfee Security Suite . . . . . . . . . . . . . . Herb Lavin
Assorted CDs- Winnie the Pooh . . . . . . Don Pianka

The meeting adjourned at 8:28 PM.

John Hunter, secretary �

  Minutes of April 4, 2006
— John Hunter, Secretary  

Spring Cleaning . . .
Along with cleaning out and backing up

files on your computer, take care to clean
the hardware. Unplug your computer and
wipe all exterior parts with a damp cloth.

If you intend to open your computer
case [the tower] make sure to ground
yourself beforehand. Touch something
metal, or use a special gadget to keep you
from generating static electricity—a deadly
enemy of the computer.

Use compressed air to blow dust from
your fan and keyboard.



Word Processing Tips
— by Bob Schaffer

Receive a Word and a WordPerfect tip

every other week

 by email from Bob Schaffer. 

Send your request to

rdschaffer@adelphia.net.
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WORD — Control how your new style displays in
an outline  (2000/2002/2003) 

Outline levels are display tools that work in
conjunction with paragraph and heading styles. Often,
when you're editing a document, you need to see your
document's hierarchical structure in Outline view or in
the Document Map. If you take a few moments to set
appropriate outline levels, organizing your document in
Outline view is a simple matter. If you don't select
outline levels for your custom styles, you won't find all
the information you need in Outline view. 

When you create a new style, the outline level is
automatically the same as the outline level of the style
that you based it on. For example, if your new style is
based on Word's built-in Heading 1 style, its outline
level is set to 1 by default. If you choose not to base
your new style on an existing style, then your new
style's outline level defaults to Body Text.

To change a new style's outline level:
1. In the New Style dialog box, click Format and select

Paragraph from the resulting dropdown list.
2. In the Paragraph dialog box, click on the Indents

And Spacing tab (if necessary), and in the General
area, select the outline level you want from the
Outline Level dropdown list.

3. Click OK to close the Paragraph dialog box, and
continue specifying the features of your new style.
Notice that the Outline Level setting you applied is
reflected in the Description area of the Modify Style
dialog box, which is located below the preview
window. 

4. Click OK in the New Style dialog box to create your
new style.

— Determine where a word can break 

There are multiple places that words can break. You
can break the word Microsoft at any of these hyphens:
Mi-cro-soft. You can choose where a particular word
should be hyphenated by inserting an optional hyphen. 

Type the first part of the word, and then press
[Ctrl][-] then finish typing the rest of the word. You
probably won’t see the hyphen onscreen, the word
breaks at the appropriate place if it appears at the end
of a line and a break is necessary. 

WORDPERFECT — Hide and go print. (10/11/12)

If you want to make a few notes to yourself that
won't reach the printed version of your document, try
hidden text. 

Type out the disappearing text, select it, and
choose Font under the Format menu. 

Click the checkbox labeled Hidden. 
Click OK. 
Now go to the View menu and click Hidden Text

to see it or send it away. 
Before you attempt to print, deselect Hidden Text

in the View menu and make sure the formatting of
your remaining text is as you want it.

— Highlight text

People can't get enough of highlighters on paper,
and you'll come to appreciate them in WordPerfect, as
well. 

Highlight a word or phrase by selecting it and click
the Highlight button—it looks like a pen drawing a
yellow line. 

Change colors by clicking the tiny arrow next to the
button. 

Remove highlights by selecting the text, then click-
ing Highlight in the Tools menu and choosing Re-
move. 

Note that the Highlight menu also lets you make all
highlighting disappear at once by toggling the
Print/Show option.

— Start a tab 

Quickly add tab stops by clicking the ruler above
your document on the point where you want the stop
to appear. 

You can add different types of stops using the
button to the left of the ruler, which displays a small
triangle by default. 

A click shows a menu of various types of tab stops,
as well as a command for clearing all stops at once. �

mailto:rdschaffer@adelphia.net.
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Q. Can you tell me the latest release date of the Windows
Vista operating system? I prefer to wait to buy a computer
until this is released, but I do not want to wait too long. I’m
using Windows 98 now. Thanks.

A. Your guess is probably as good as anyone’s. Microsoft
has not announced a release date. However, it has said that
it expects to have Vista out sometime next fall.

There’s plenty of speculation on the Web. I found dates
in October, November and December. But I have no reason
to believe those writers know anything.

Vista, which is in beta testing, is the planned successor
to Windows XP. The latter was released in October, 2001.
So it will be five years old when Vista finally comes along.
That is an eternity in Windows-time. (Windows 98 is nearly
eight years old. So I can see why you’d rather not wait!)

You could purchase a computer and upgrade later.
Problem is, Microsoft has not released minimum system
requirements for Vista. I found these three suggestions on
the company’s site:
• 512 megabytes of random access memory
• A graphics card that supports DirectX 9.0
• A modern Intel or AMD chip

DirectX is a collection of interfaces that facilitates
game programming for Windows. You don’t need to know
anything about it. Just look for it in your video card’s
specifications. Any decent video card will support DirectX.

As for the other specs, I would get at least 1 gigabyte
of RAM. Be sure that the computer can be upgraded to 2
GB. If you are a serious gamer or do a lot of video work,
I’d look for a 64-bit chip with dual cores. Otherwise, get a
chip that is three or four steps down from the top. Either
AMD or Intel is fine.

Presumably, Microsoft will offer an upgrade to
Windows XP. That could be problematic. As I recall, the
Windows 95 upgrade to Windows 3.x worked fine. So did
the Windows 98 upgrade to Windows 95. But I had real
problems with a Windows XP upgrade to Windows 98. I’ve
heard that story from others, too.

Windows XP was a radical change from Windows 98
and its successor, Windows ME. So that might account for
the problems. Nonetheless, a Vista upgrade could turn out
to be dicey. In that case, you would have to format the hard
drive and install everything fresh. Think hard about whether
you want to tackle that.

So, here’s my bottom line: If you can wait, do so. Vista
should be available in less than a year. By that time, system
requirements will be clarified. And you won’t have to worry
about a flakey upgrade.

Q. I’ve listened to you for 10 years. I have wanted a laptop
for years and finally have the money. I’m going crazy
trying to make sure that my new machine is Windows
Vista-ready. I have tried to follow your recommendations,
but am not sure what they are. Could you please address
this before I lose my mind?

A. I apologize if I have confused you. Windows Vista is a
moving target. We are running a test version on a machine
in the office. But the components of that test version may
well be changed when Vista finally emerges.

For those who don’t know, Vista will be the successor
to XP. Microsoft said it will be released by late this year.

We discussed this situation in the office last week. If
you’ve been listening to the radio show, you know others
have your problem. Some people are still using Windows
98, and they need to make a decision.

Here is my first recommendation: If you can wait, do
so. If your system is eight years old and is staggering
toward the grave, that may not be possible. But Vista is
likely to be a very big change. I suspect upgrading to Vista
will be a hassle.

Furthermore, laptops can be especially troublesome.
Adding or changing components is much more difficult,
because of the tiny space available. And many components
are proprietary, so they tend to be expensive.

If you wait until Vista is released, the laptop will
already have it installed. It will be designed to run with
Vista, so the machine’s components should work well.

What do you do if you can’t wait? Buy a high-end
machine. I would get a 64-bit chip, and 1 gigabyte of
random access memory, minimum. If you do video work,
get 2 GB. And insist on a separate video card with at least
128 MB of RAM. Microsoft is warning against machines
with video systems built in to the motherboard.

You should also get a DVD drive. Be sure it has the
capability to burn DVDs. DVD drives can play and burn
CDs, too, so a separate CD drive is unnecessary. 

You also should get a large hard drive. Dig into the
specifications. It should be Serial ATA, not IDE, according
to Microsoft. I know some machines are being sold as
“Vista-ready.” If you decide on one of those, be sure it
meets the specifications I’ve laid out.

No doubt, Vista will be worth owning. However, many
changes will be cosmetic. Windows XP is a good operating
system, and will remain usable for years. So, you don’t
have to upgrade when Vista emerges. 

Microsoft will hype Vista as the only way to go, as it
always does with a new operating system. View that with
skepticism; Microsoft says the same thing about XP now.�

Copyright 2005 WestStar TalkRadio Network. Subscribe to Kim

Komando's free e-mail newsletters at: www.komando.com

Microsoft’s Vista
— by Kim Komando

http://www.komando.com
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Music to My Ears
Headlines scream “School District to Cut

Programs” or “Music and Art Deemed a Frill.”
Welcome to 21  Century reality. But are these culturalst

educational offerings really a frill as some suggest? 
Paul McCartney doesn’t think so. 

Sir Paul McCartney, of Beatles fame, recently 
established a music education foundation to promote
music education and young talent. In addition to his
own funds, McCartney persuaded Fidelity Investments
to pony-up $1 million to provide start-up money and
additional money to purchase new instruments for
children.

The foundation web site at musiclives.org provides
supporting facts for this activity. Such as: music helps
kids develop critical thinking, basic math and reading
skills; music students score 100 points higher on
SATs; and music even enhances social skills.

Because budget cuts nationally may eliminate music
education for some 30 million kids, the ability to play
some obscure instruments like the oboe may become
extinct. While the oboe is certainly not as popular as
the piano or the guitar, it turns out that the oboe is the
instrument every other instrument in orchestras tune
to. 

If you wish to help the foundation “enhance lives,
open hearts, and improve intellectual and social
development, visit the site and see how you can make
a difference.

Blogs and Blogs
Opinions are like bellybuttons - everybody has one,

opines the cliche. Blogs (personal web logs) appear on
many topics and provide readers with personal views
on any number of subjects. Even educators who resist
every change have now joined the mad rush to inflict
personal opinions on the unwary.

Classroom teachers now produce many blogs, both
as individual vehicles for their own thoughts and as
classroom tools for their students. Educational blogs
come in all shapes and sizes. Weblog-ed.com provides
a gateway into the blog arena. When you visit this site,
you are encouraged to click on links that provide the
how’s, the why’s and the wherefore’s of blogdom.

Want to find out what people think about software,
personal finance, automobiles, employment,
education, gambling and so on? This site provides
links to all these topics and more. I clicked on
education and found online schools for nursing,
technical education, school fundraisers, golf
instruction, and the ever-present “get your high school
education at home” offerings. Many of these blogs are
advertising dressed-up a different way—as in putting
lipstick on a pig to improve its worth. And
unfortunately, pop-up ad blockers won’t touch this
stuff.

Read This Only If You Are Paranoid
Just because I’m paranoid, doesn’t mean people 

aren’t out to get me. Subscribe to this theory and I
have a site for you. WWW.isgoogleevil.com reeks of
paranoia. Posting after posting offers proof that
Google is in cahoots with the government (ala George
Orwell) in tracking and censoring web voyagers.
Individuals identified by names such as Fester, Chester
and Randy Siegel argue that the premier search engine
has begun to intrude into our lives in an alarming way. 

They provide as evidence Google’s willingness to
cooperate with the Chinese government to limit web
searches for Chinese web users. Further claims include
our government’s attempt to gain information on web
searches to fight terrorists and child pornographers. 

 If you can’t sleep late at night, visit this site. The
site will either put you to sleep instantly or keep you
up for days.

Sites for Children
Want to entertain young children with little effort?

Visit mothergooserocks.com/headandshoulders.html.
This site provides links to animated music videos of
nursery rhymes such as “Head, Shoulders, Knees and
Toes,” “ Home on the Range,” “ Mulberry Bush” and
others on a 20 song DVD. Links to other offerings
include “Skinamarink” by Green Week, “Mulberry
Bush” by Gwen Stuffuny, “Frere Jacque” by Dave
Mathshoes.

With all these offerings you may be reminded of
Sesame Street’s “Conjunction Junction.”song. These
songs share the driving rock beat and should be played
loudly. Just the thing for keeping kids occupied.
However, you may wish to use earplugs.

Until next time . . . �

   Sites to Visit on the ‘Net
— by John Hunter    

http://www.musiclives.org
http://Www.Weblog-ed.com
http://WWW.isgoogleevil.com
http://www.mothergooserocks.com/headandshoulders.html
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. . . that on a keyboard the upper row of keys [F1
through F12] are known as Function Keys? These are
shortcut keys that are used in Windows and various
software programs that can make your life easier. In
almost all programs the F1 key gets you to the Help
menu. F2 in Windows allows you to rename a file.
Each program will have a different use for these keys
so you should consult your manual to discover what
these keys will do in any particular program. Pressing
F12 in Word will bring up the Save As dialog box; in
WordPerfect that same key brings up the Create Table
dialog box. To get the Save As box in WordPerfect
you would press F3. If you are using a laptop
computer you access the keys a bit differently than
you do using a regular keyboard. Some of the keys
will have a blue mark and there is a blue key marked
Function. To use the blue coded keys you first hold
down the Function key and then press the key you
want. Such as—Function key+F1 For help.

. . . that Word has a toolbar that shows you the
function key options? To use this toolbar: Right-click
the empty area around the toolbars and select
Customize. Select Function Key Display on the
Toolbar Tab, then click Close. The toolbar will appear
at the bottom of the screen. WordPerfect does not
have such a toolbar because it has an extensive list of
useful function key combinations. For instance, F6 will
toggle bolding on and off from the point where the
cursor is positioned, pressing Shift+F6 centers text on
a line and lets you insert dot leaders by pressing
Shift+F6 twice, pressing Ctrl+F6 displays the Tab set
dialog box, and pressing Alt+F6 aligns text evenly
with the right margin and lets you insert dot leaders by
pressing Alt+F6 twice. To learn what each key and
combination will do you have to go to Help |
Keyboard Shortcuts | Dialog Boxes. Once there you
will also learn that there are additional options
available by using other combinations of keys.

. . . that Microsoft’s new operating system, Vista,
will not be available to the general public until 2007? 
If you plan to purchase a new computer, try to hold
off until after Vista debuts. It will be offered to
businesses in late 2006 but new computers purchased
later this year will be loaded with XP, not Vista. �

Apple has finally gone and done it. It’s offering
Microsoft Windows on its Apple computer. This
means that an Apple computer will run programs
written for either the Mac or Windows, but it will
have to shut down one system to start the other. The
hope, of course, is for Apple to gain more users. Wall
Street’s immediate response? Apple’s stock jumped
almost 10 percent. It’s also reported that those Apple
users who for years poked fun at the users of the PC
are now enthusiastic about this move to Windows. 

It is amazing to me that Apple is now embracing
the Windows operating system after years of
considering it
tortured, frustrating,
“unbearable and
unsafe.”

The new Apple
system is called Boot
Camp and is being
introduced as a free
download. Maybe we
should have seen it
coming. The Mac acquired the use of Microsoft’s
Word a few years ago, and at that time Microsoft
invested in the Mac.

After that, Apple got its very popular iPod  iTunes
software running on the PC platform.

And after that, Apple’s Jobs broke from IBM and
went with the Intel microprocessor. Some people do
think of all this as two great religions opening their
doors for the Mac-Windows wedding. 

What next? The technocrats are already setting
their sights on running Windows, the Macintosh and
Linex simultaneously. In the meantime we can look
forward to even more Mac machines being reviewed
in the PC magazines. Indeed, in just a few years the
Mac and PC magazines will begin to merge, their
distinctions blurred. There will be less Mac self-
proclaimed gods looking down on the poor misguided
users of the PC. Maybe we will all be more helpful
across platforms, more harmonious. Who knows,
maybe the merger of the Mac and the Windows
platforms will promote the merging of our local
computer groups. What SIGs! What a website! What
a newsletter! What possibilities! �

  Did You Know . . .
— Donna Gorrell   

   Byting Remarks
— Jerry Finkelstein   
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